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2017-2018 ANNUAL REPORT 

University of Washington Student Chapter  

of the Earthquake Engineering Research Institute 

Report Date: May 1, 2018 

This report summarizes the membership and activities conducted by the University of Washington Student 

Chapter of the Earthquake Engineering Research Institute during the 2017-2018 academic year. 

MISSION & GOALS 

The Earthquake Engineering Research Institute University of Washington Student Chapter (EERI/UW) was founded 

in 2016 under the following mission: 

 

To prepare future leaders in earthquake engineering, science, and policy through 

interdisciplinary dialogue, professional engagement, and public outreach. 

 

Though founded within the Department of Civil and Environmental Engineering, current leadership envisions the 

chapter as a hub for learning and fellowship with other departments across campus and external organizations. 

In doing so, the chapter will connect its members with resources to support earthquake engineering research 

and teaching activities, open career pathways, and serve the public. 

 

MEMBERSHIP 

The University of Washington Student Chapter had a total of 7 members in 2017-2018. All current members are 

students in the Department of Civil and Environmental Engineering. 
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OFFICERS 

The Board consisted of the following members: 

Role Name EERI Member  
Number 

Email Student Status 

President Andrew Sen 18606 adsen@uw.edu Graduate student 

[former] Vice President Alex Grant 18939 agrant3@uw.edu Graduated 12/2017  

Secretary Nasser Marafi 17509 marafi@uw.edu Graduate student 

Graduate Student Representative Tianye Yang 18949 tianyy3@uw.edu Graduate student 

 

FACULTY & INDUSTRYADVISORS 

The faculty and industry advisors are: 

Role Name EERI Member  
Number 

Email Affiliation 

Faculty Advisor Paolo Calvi 18165 pmc85@uw.edu University of Washington 

[former] Contact 
Member 

Erica Fischer 13586 efischer@degenkolb.com Degenkolb Engineers 

The chapter will seek a new contact member for the 2018-2019 academic year after elections in May 2018. The 

contact member is expected to be selected in collaboration with the Washington Regional EERI Chapter. 

MEMBERS 

A complete list of members is shown below. 

Name EERI Member Number Email Student Status 

Sarah Wichman - wichman@uw.edu Graduate student 

Andrew Winter 18956 andrew25@uw.edu Graduate student 

Kamal Ahmed 18957 kamal2@uw.edu Graduate student 

 

BUDGET & FINANCIALS 

The chapter’s finances are directly related to the rapid visual screening project undertaken in the summer of 

2017. The chapter holds an outstanding balance of $7870.71 which may be used for future chapter activities 

including meetings, expert seminars, on- and off-campus earthquake engineering educational outreach, and 

participation at future EERI Annual Meetings (including dissemination of project experiences and outcomes). 

Description Income Expenses Balance 

Rapid Visual Screening Project (DNR) $9900.00  $9900.00 

RVS Travel Reimbursement (A. Sen)  $1132.10 $8767.90 
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RVS Travel Reimbursement (N. Marafi)  $767.19 $8000.71 

RVS Travel Reimbursement (T. Yang)  $130.00 $7870.71 

 

CHAPTER ACTIVITIES 

EERI/UW did not hold regular chapter meetings for the 2017-2018 academic year but has coordinated several 

substantial activities both on- and off-campus. The following sections describe each activity in detail. 

Rapid Visual Screening in Central Washington  

In the summer of 2017, EERI/UW undertook a substantial research project evaluating potential seismic hazards in 

Central Washington. The project was supported through funding by the Washington State Department of Natural 

Resources (DNR) and served as part of a broader school earthquake safety initiative led by Recep Cakir of the 

Washington Geological Survey (WGS) at DNR. Three volunteer students from EERI/UW surveyed 44 school 

campuses across Chelan and Okanogan Counties using the Level-2 Rapid Visual Screening procedure outlined 

by FEMA P-154. The project was completed in three phases covering different locales: Wenatchee School District, 

Chelan County ex-Wenatchee, and Okanogan County.  

      

The chapter delivered a final report of their findings to WGS on August 24, 2017. A copy of the report is attached 

with individual school names redacted to preserve anonymity. The project proved to be a valuable experience 

for all involved while providing a much-needed service to the community; students developed skills in proposal 

writing, project management, budgeting, field investigation, and professional communication (including 

considerable coordination with each school district). 

University of Auckland Joint Meeting 

On April 26, 2018, EERI/UW held a joint meeting with the University of Auckland QuakeCoRE Emerging Researchers 

Chapter (see attached meeting announcement). The meeting introduced students and outside visitors to their 

counterpart organizations and featured research presentations related to cross-laminated timber (CLT) wall 

seismic-force-resisting systems being conducted at each university. Twelve students (4 graduate, 8 

undergraduate) attended the meeting in Seattle. 

Sarah Wichman, a master’s student from EERI/UW, presented her experimental research on full-scale shake-table 

testing of CLT walls conducted at the University of California, San Diego (UCSD). The walls utilized post-tensioning 
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and rocking to provide self-centering performance with minimal damage, and the test results will be applied 

toward the development of a 10-story CLT-wall specimen to be tested at UCSD in the future. 

Post-doctoral fellow Ashkan Hashemi from the University of Auckland presented his doctoral research on resilient 

slip-friction joints (RSFJs) with an emphasis on their use in CLT wall construction. Validated using experimental and 

numerical methods, the joints offer a novel approach for providing self-centering behavior with significant energy 

dissipation. 

Educational Outreach: Central Washington 

Note: This activity was conducted in the 2016-2017 academic year but was previously unreported. 

In early 2017, EERI/UW members participated in two educational outreach events for third- through fifth- grade 

students in Wenatchee School District. EERI/UW visited Columbia Elementary School and Sunnyslope Elementary 

School on February 23 and April 11, 2017, respectively. These events, were coordinated with scientists from the 

Washington Geological Survey (WGS) to educate students on the subjects of geology and engineering as they 

relate to seismic hazards. Each visit was preceded with educational activities from WGS covering seismology and 

geotechnical engineering, including the use of field instrumentation to detect seismic waveforms. In the following 

day, EERI/UW students adapted EERI’s School Earthquake Safety Initiative (SESI) fourth-grade curriculum to 

provide a brief (approximately 20-minute) lesson on structural engineering, followed by an interactive shake-

table demo. Students built and tested their own structures out of K-Nex and were then guided by the instructors 

to design repair and retrofit measures to improve seismic performance. 

       

Educational Outreach: Engineering Discovery Days 

The EERI/UW hosted an earthquake engineering exhibit entitled “Make It and Shake It: Your Buildings, Our 

Earthquakes” at the University of Washington’s annual Engineering Discovery Days (April 19 and 20, 2018). The 

chapter has formally participated since 2016 when the exhibit was adapted from a prior, long-running exhibit 

developed by students at the University of Washington. In its current form, the exhibit introduces K-12 students to 

the local seismology of Western Washington and how structural engineers design earthquake-resistant buildings. 

These concepts are delivered interactively using a small shaking table and wooden building models constructed 

by the students. Each building is subjected to ground motions recorded in the Northridge (crustal) and Nisqually 

(intraslab) earthquakes, as well as a simulated Mw-9 Cascadia Subduction Zone earthquake provided by the 

University of Washington’s “M9 Project.” 
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ELECTION & ELECTION RESULTS 

An election for officers for the 2018-2019 academic year will be held in late May 2018.  

LIST OF ATTACHMENTS  

Included at the end of this report are various attachments to supplement the information included above.  A list 

of the attachments is included below: 

• Final Report: Rapid Visual Screening of School Buildings toward a Seismically Resilient Central Washington 

(reduced version with school names redacted) 

• University of Auckland Joint Meeting Announcement 

• Engineering Discovery Days Handout 



RAPID VISUAL SCREENING OF SCHOOL BUILDINGS TOWARD A 

SEISMICALLY RESILIENT CENTRAL WASHINGTON 

 

 

FINAL REPORT 

 

 

Prepared for 

Washington Geological Survey 

Washington State Department of Natural Resources 

 

Recep Cakir Project Lead 

 

 

August 24, 2017 

 

 

Prepared by 

Earthquake Engineering Research Institute University of Washington Student Chapter 

Andrew D. Sen President 

Nasser A. Marafi Secretary 

Tianye Yang Graduate Representative 
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1 INTRODUCTION 

School earthquake safety is a critical component of community seismic resiliency. School facilities 

have both physical and societal importance, since they serve as: 

• Primary sources of seismic hazard and hazard mitigation education for the general 

public, 

• Nearly daily shelter for students, faculty, and staff, and 

• Potential post-earthquake shelter and/or bases for emergency management 

operations. 

Thus, schools are expected to function well in their various roles before, during, and after seismic 

events as described in Table 1. 

Table 1. Schools in Seismic Resiliency Context. 

Time Function Community resiliency goal 

Before event Earthquake-related education Preparedness 

During event Building collapse prevention Preservation 

After event Shelter and operations base Recovery 

 

To advance school earthquake safety in Central Washington, the Earthquake Engineering 

Research Institute University of Washington Student Chapter (EERI/UW) has conducted rapid 

visual screening (RVS) for potential seismic hazards at school facilities in Chelan and Okanogan 

Counties (shown in Fig. 1). This work is part of a broader project conducted by the Washington 

Geological Survey (WGS) of the Washington State Department of Natural Resources (DNR) to 

assess the seismic risk of these buildings based on structural, geotechnical, and seismological data. 

Educational outreach was conducted by WGS and EERI/UW as a secondary component of this 

project. This document focuses only on potential structural hazards identified using the FEMA P-

154 RVS procedure (FEMA 2015a). 
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Figure 1. Counties in study area with active, known, and suspected faults shown (adapted from 

DNR [2017]). 

 

2 RAPID VISUAL SCREENING 

2.1 Overview 

The RVS procedure described in FEMA P-154 (FEMA 2015a) was used by EERI/UW to survey 

school buildings for potential seismic hazards. The speed of the procedure is advantageous but 

inherently leads to inaccuracies and imprecision in data collection. For this reason, the results of 

RVS must be interpreted with caution. The results do not necessarily suggest a particular building 

is safe or unsafe due to the coarseness of the procedure and the fact that each building must be 

placed in appropriate geotechnical and seismological context (a goal of the follow-up HAZUS 

analysis by WGS). The authors suggest that the RVS results, and ultimately the HAZUS results, 

should be used to identify candidate facilities for more detailed structural evaluation. 

2.2 Scope of Work 

Rapid visual screening was completed for all school campuses listed in Table 2 between July 10 

and August 1, 2017. Nearly all schools were visually inspected from the interior; schools in 
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Tonasket School District were inspected from the exterior only. As available, drawings of 

buildings were reviewed to enhance data collection accuracy. It is noted that drawings are highly 

useful, since schools are often heavily partitioned and designed such that their structural 

components are hidden from sight. 

 Each school campus in Table 2 may be comprised of multiple buildings that are either 

completely separated, connected along a seismic joint, or built adjacent without adequate 

separation. 

2.3 Seismicity 

Following the FEMA P-154 documentation, the designated seismicity for Chelan and Okanogan 

Counties was “Moderately High” (Figure 1-3 of FEMA P-154) (FEMA 2015a). While seismicity 

varies within the region based on short- and long-period spectral accelerations (Table 2-2 of FEMA 

P-154), a uniform seismicity was selected for simplicity. This designation affects the final RVS 

score but not the outcome of the seismic risk assessment in HAZUS. 

2.4 Geologic/Geotechnical Data 

2.4.1 Geologic Hazards 

Mapped geologic liquefaction, landslide, and surface rupture hazards were extracted from the 

Natural Hazards Interactive Map provided by DNR (2017). A liquefaction susceptibility of 

“moderate-to-high” was selected as the threshold for the RVS form. Landslide hazards are less 

clear based on the mapped data, and the authors could not identify the presence of landslide hazard 

with adequate certainty. Therefore, only “No” and “DNK” (“Do Not Know”) landslide hazard 

designations were used. With the exception of Entiat School District, all sites surveyed were 

located sufficiently far from active, known, or suspected faults and therefore have no surface 

rupture vulnerability. Entiat School District is located in a region with notable recent seismic 
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activity but no mapped faulting, and therefore its surface rupture vulnerability is designated as 

“DNK” (Brocher and Cakir 2016). 

Table 2. School Campuses Surveyed and Soil Properties. 
County District Facility Grade Vs30 (m/s) Soil type 

Chelan Cascade  E 353.7 D 

Chelan Cascade  E 536.0 C 

Chelan Cascade  E 427.2 C 

Chelan Cascade  M 432.2 C 

Chelan Cascade  H 432.2 C 

Chelan Cashmere  E 443.4 C 

Chelan Cashmere  M 411.9 C 

Chelan Cashmere  H 411.9 C 

Chelan Entiat  EMH 301.4 D 

Chelan Lake Chelan  E 276.0 D 

Chelan Lake Chelan  E 276.0 D 

Chelan Lake Chelan  MH 308.7 D 

Chelan Manson  E 379.0 D 

Chelan Manson  MH 379.0 D 

Chelan Wenatchee  E 387.3 D 

Chelan Wenatchee  E 289.7 D 

Chelan Wenatchee  E 293.1 D 

Chelan Wenatchee  E 306.7 D 

Chelan Wenatchee  E 381.8 D 

Chelan Wenatchee  E 339.0 D 

Chelan Wenatchee  E 290.5 D 

Chelan Wenatchee  M 364.6 D 

Chelan Wenatchee  M 329.5 D 

Chelan Wenatchee  M 268.9 D 

Chelan Wenatchee  H 247.9 D 

Chelan Wenatchee  H 339.8 D 

Chelan Wenatchee  EMH - D 

Okanogan Brewster  E 286.0 D 

Okanogan Brewster  MH 286.0 D 

Okanogan Grand Coulee Dam  EMH 327.6 D 

Okanogan Methow Valley  E 322.4 D 

Okanogan Methow Valley  MH 322.4 D 

Okanogan Nespelem  EM 384.3 D 

Okanogan Okanogan  E 282.3 D 

Okanogan Okanogan  MH 294.8 D 

Okanogan Omak  E 311.9 D 

Okanogan Omak  E 309.3 D 

Okanogan Omak  M 227.0 E 

Okanogan Omak  H 227.0 E 

Okanogan Oroville  E 254.5 D 

Okanogan Oroville  MH 254.5 D 

Okanogan Pateros  EMH 332.9 D 

Okanogan Tonasket  E 320.0 D 

Okanogan Tonasket  MH 320.0 D 

Note: E = Elementary, M = Middle, H = High 
aPartial exterior inspection only 
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2.4.2 Soil Type 

Site-specific soil types were provided by WGS based upon newly collected Vs30 data at each 

school campus (see Table 2). Sites with Vs30 values near soil-type boundaries were classified 

conservatively. 

2.5 Structural Engineering Assumptions 

2.5.1 Building Type 

Due to architectural constraints, it was sometimes not possible to identify building type with 

absolute certainty. Examples include steel braced frames where the braces are hidden within the 

wall system and masonry buildings where reinforcing steel is hidden. In the latter case, presence 

of masonry reinforcing steel was assumed based on building age. Masonry buildings constructed 

as late as the 1960s were assumed to have unreinforced masonry (URM) lateral-force-resisting 

systems, while buildings constructed later were assumed to be reinforced (RM1 or RM2). 

2.5.2 Year Built and Code Designations 

In most cases, year built was provided through verbal communication with administrative and/or 

custodial staff or review of building drawings. Where this information was unavailable, year built 

was estimated based on building condition and construction type (estimated values are noted on 

the RVS form). Code year was only provided if known from building drawings, but can be 

estimated for HAZUS analysis based on Ash et al. (2017). 

Building designation as “pre-code” or “post-benchmark” is critical to the final RVS score. 

Pre-code buildings were constructed prior to the adoption of building codes (FEMA 2015a). The 

first statewide building code in Washington was adopted in 1975 (Ash et al. 2017), and therefore 

buildings constructed prior were designated as “pre-code.” Post-benchmark buildings were 

constructed after the adoption of “substantially improved codes” (FEMA 2015a). For simplicity, 
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this designation was applied to all buildings in this survey built after 1997, since this era 

corresponds to the adoption of key ductile design provisions across multiple building types (FEMA 

2015a). 

2.5.3 Building Additions and Separation 

Schools can be particularly complicated structures to evaluate for potential seismic hazards 

because they typically contain multiple additions and/or buildings within the same facility. For 

example, it is common for a school campus to have a gymnasium with a lateral-force-resisting 

system that is distinct from the main building (classrooms). In these cases, it must be determined 

whether the additions and/or buildings are separated. If seismic joints were visible, the 

buildings/additions may be screened separately. In cases where no seismic joints were visible, the 

following rules were applied: 

1. If the buildings/additions maintain the same lateral-force-resisting system with 

shared story heights, screen as the same building. 

2. If the buildings/additions maintain the same lateral-force-resisting system with 

different story heights, screen as the same building with split-level vertical 

irregularity. 

3. If the buildings/additions have different lateral-force-resisting systems, screen as 

separate buildings with pounding modifiers on both structures. 

2.5.4 Total Floor Area 

In most cases, total floor area was estimated using Google Earth’s “Polygon” tool (Google 2017). 

For Wenatchee School District, nearly all floor areas were provided through facility summary 

reports obtained from the district office. 
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3 SURVEY RESULTS 

3.1 Overview 

A total of 122 building components were identified and evaluated across 44 school campuses in 

Central Washington. Each school campus evaluation required between 30 and 60 minutes to 

conduct building-walkthrough inspection, drawing review, and staff interview. Completed RVS 

forms for each building component can be found in Appendix A. 

3.2 Building Metadata 

These schools were constructed over a broad time period—between about 1940 and 2016. Many 

school campuses were comprised of building components constructed in different generations. 

Figure 2 shows construction-year histograms for all building components, main building 

components (e.g., classrooms), and gymnasium components from top to bottom. Where year built 

was unknown, engineering judgment was exercised to estimate the decade of construction. Most 

school building components in Chelan and Okanogan Counties were constructed between 1980 

and 2000, though it is clear that a substantial stock of buildings exist from the pre-1980s era (and 

therefore the pre-code era). Such buildings likely have elevated risk of damage in seismic events, 

since building codes have evolved substantially to reflect advancements in knowledge of seismic 

hazards and structural behavior. 

 Several school districts (e.g., Cascade School District) are in the process of renovating and 

replacing school buildings, and therefore it is expected that this data will shift toward the right in 

the near future. 
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Figure 2. Year built by building use (variable components). 

 

 Figure 3 shows that the buildings evaluated were predominantly reinforced masonry 

construction with flexible diaphragms (RM1). These buildings were most commonly constructed 

between 1975 and 1997, but they remained the most common post-benchmark construction type. 

Steel concentrically braced frames (S2) also comprised a substantial proportion of post-benchmark 

construction. It should be noted that precast reinforced concrete tilt-up construction (PC1) was 

primarily limited to gymnasiums. 

 Pre-code (pre-1975) lateral-force-resisting systems included wooden shear walls (W2), 

reinforced concrete frames with unreinforced masonry infill walls (C3), reinforced masonry shear 

walls (RM1), and unreinforced masonry shear walls (URM). Most pre-code construction consisted 

of URM, which are known to be seismically vulnerable due to their nonductile behavior. 
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Figure 3. Building type by construction era (all components). 

 

3.3 Geotechnical Hazards 

Assessment of the effects of geotechnical hazards such as soil liquefaction and landslide risk was 

beyond the scope of the rapid visual screening study. However, these effects inevitably contribute 

to the overall seismic performance of school campuses. Soil liquefaction susceptibility was 

identified using DNR’s Natural Hazards Interactive Map (2017), and the distribution of 

susceptibility levels is depicted in Fig. 4. Ten (10) school campuses, mostly in Okanogan County, 

have mapped moderate-to-high liquefaction susceptibility. These campuses likely require further 

geotechnical evaluation to verify liquefaction potential. 
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Figure 4. School campus liquefaction susceptibility. 

3.4 Rapid Visual Screening Scores 

Building component scores are the primary output of RVS evaluation. The scores are related to 

collapse probability as described in FEMA P-155 (FEMA 2015b). A given score X implies a 10-X
 

probability of collapse in the risk-targeted maximum considered earthquake (MCER) (FEMA 

2015a). As such, a building component with Risk Category III (most schools) should have a score 

of at least 1.22 in order to meet the ASCE 7-10 performance objective of less than 6% probability 

of collapse in the MCER (ASCE 2010). While the data collected as part of the RVS will ultimately 

be used in HAZUS analyses performed by WGS to provide a more rigorous risk assessment, the 

RVS scores provide a preliminary understanding of the seismic vulnerability of schools in Central 

Washington. 

 Both Level 1 (SL1) and Level 2 (SL2) RVS scores are provided in this document in 

Appendix B. Level 2 scores are determined from slightly more detailed building evaluations and 

therefore are intended to provide more accurate estimates of collapse probability. Figure 5 shows 

SL1 and SL2 histograms for all building components evaluated. The minimum and maximum 

scores for both levels of evaluation were 0.2 and 5.5, respectively. A building with a score of 0.2 
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suggests a 63% probability of collapse in the MCER. This is a severe seismic vulnerability, and 

such buildings are clear candidates for more detailed structural evaluations. 

 
Figure 5. Rapid visual screening score by building component. 
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Level 2 evaluations resulted in lower scores on average (negative SL2 – SL1). The mean 

Level 1 score was 2.0, while the mean Level 2 score was 1.7. This variation can be primarily 

attributed to the inclusion of adjacency hazards (pounding) in the Level 2 evaluation. 

Since school campuses may be comprised of multiple buildings of different construction 

type, era, and occupancy, it is useful to consider the scores in a weighted-average sense for an 

individual campus. In Table 3 and Fig. 6, weighted-average scores are computed for each campus 

using Eq. 1, where SLcampus is the campus score, SLi is the component score and Ai is the total floor 

area of the component. 

 𝑆𝐿𝑐𝑎𝑚𝑝𝑢𝑠 =
∑ 𝑆𝐿𝑖𝐴𝑖𝑖

∑ 𝐴𝑖𝑖
 (1) 

The minimum and maximum Level 1 campus scores are 0.5 and 5.1, respectively. The 

Level 2 campus scores range from 0.3 and 5.2. Less than two-thirds of school campuses in Central 

Washington appear to meet the 6% probability of collapse minimum for MCER shaking. The mean 

Level 2 campus score was 1.7, with 39% of campuses scoring below 1.22. However, it should be 

recognized that the relatively coarse RVS procedure may provide a conservative estimate of 

seismic vulnerability, and the subsequent HAZUS study is expected to produce overall lower 

probabilities of collapse with the inclusion of site-specific seismological and geotechnical data. 
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Table 3. Campus RVS Scores. 
Campus SL1 SL2 

 4.1 4.1 

 2.2 1.3 

 1.3 0.5 

 1.7 0.8 

 0.5 0.9 

 3.6 3.6 

 1.9 1.0 

 2.1 1.6 

 2.6 2.6 

 1.7 2.0 

 1.6 1.7 

 2.0 1.5 

 2.2 2.2 

 2.1 1.7 

 1.8 1.8 

 2.6 2.1 

 2.1 1.7 

 0.5 0.9 

 5.1 5.2 

 1.3 0.5 

 2.5 1.8 

 1.1 1.2 

 2.1 1.8 

 2.0 1.2 

 2.1 1.1 

 1.5 1.0 

 1.4 1.6 

 1.7 1.8 

 0.6 0.7 

 0.9 0.6 

 2.0 1.1 

 0.5 0.3 

 2.1 2.8 

 1.8 1.1 

 1.2 1.3 

 0.8 1.1 

 2.5 2.0 

 1.8 1.8 

 1.8 1.8 

 2.1 1.7 

 0.5 0.5 

 3.5 3.5 

 1.0 1.1 

 1.5 2.2 
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Figure 6. Weighted rapid visual screen score by campus. 

 

4 SUMMARY AND CONCLUSIONS 

Knowledge of the seismic vulnerability of schools is critical toward advancing community 

resiliency. Schools are centerpieces of communities both as education centers and structures, and 
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they are expected to perform well in seismic events in order to preserve the lives of their occupants 

and enable community recovery. Many schools in Central Washington are considered to have 

moderately high seismic risk (FEMA 2015a) but some date back to the 1940s, well before the 

introduction of a statewide building code (Ash et al. 2017) and adoption of ductile design 

provisions. To help quantify potential seismic hazards of structures in Chelan and Okanogan 

Counties, EERI/UW surveyed 44 school campuses using the FEMA P-154 Rapid Visual Screening 

(RVS) procedure (FEMA 2015a). Each building component identified was assigned an RVS score, 

where possible, to indicate collapse vulnerability in the risk-targeted maximum considered 

earthquake (MCER). Nearly 40% of the school campuses in the two counties appear to fall below 

the targeted reliability in ASCE 7-10 (ASCE 2010). However, interpretation of the RVS scores 

should be approached with caution because: 

• The procedure is necessarily simplistic and conservative, 

• Score varies with seismicity, which varies in the study region (only moderately high 

seismicity was considered), 

• Building risk category, and hence design strength, may vary depending upon 

building code, and 

• Collapse prevention may be a misleading performance objective, since a higher 

level of performance is likely desired for schools. 

The HAZUS analysis to be performed by WGS will address several of these concerns to provide 

a clearer picture of seismic vulnerability of schools in Central Washington, and ultimately help 

identify candidate schools for more detailed structural evaluation (e.g., ASCE 41-13 [ASCE 

2013]). 
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Earthquake Engineering Research Institute 
University of Washington Student Chapter Meeting 
 
Date: Thursday, April 26 
Time: 5:00pm - 6:00pm 
Location: MOR 110 
 
Large-Scale Testing of Post-Tensioned CLT Rocking Walls 
Sarah Wichman, PhD Student, University of Washington 
 
With the recent development of engineered wood products such as cross laminated timber, tall timber 
buildings are becoming feasible and offer benefits such as faster construction and the use of sustainable 
building materials.  It has also opened the door to creating seismic resilience systems that sustain minor 
damage during large earthquakes. With this in mind, the NHERI TallWood Project funded by the National 
Science Foundation created a full-scale two-story mass timber building and tested it on the world’s largest 
outdoor shake table in San Diego, California at the NHERI@UCSD facility. The lateral system consisted 
of two cross laminated timber post-tensioned rocking walls designed using performance-based seismic 
design concepts. In addition, numerical modelling of the rocking is being done using OpenSEES. 
Preliminary results from this test show that post-tensioned CLT rocking walls can provide great seismic 
performance while remaining essentially damage free. 
 
Bio:  
Sarah Wichman is a doctoral candidate in the Department of Civil and Environmental Engineering at the 
University of Washington. She moved to Seattle, Washington for her PhD in 2016 after earning a BS in 
Civil Engineering from the University of Wisconsin, Madison. Her research at Washington focuses on full 
scale dynamic testing and modeling of seismically resistant post-tensioned rocking CLT walls with 
Professor Jeff Berman.  
 

Development of Resilient Seismic Solutions for Damage Avoidance Design of Timber Structures 

Using Resilient Slip Friction Joint (RSFJ) Technology 

Ashkan Hashemi, Postdoctoral Fellow, University of Auckland 

There is an increasing public pressure to have damage avoidance structural systems using Cross 

Laminated Timber (CLT) in high seismic active countries to minimize the destruction after severe 

earthquakes with no post-event maintenance. This study presents damage avoidance Lateral Load 

Resisting Systems (LLRS) using rocking CLT walls and the innovative Resilient Slip Friction Joints 

(RSFJs). RSFJs can be used as hold-downs or as ductile links between the adjacent walls or between 

the walls and the boundary columns. These joints are capable to provide a self-centering behaviour (the 

main shortcoming of conventional friction joints) in addition to a high rate of energy dissipation all in one 

compact package. The proposed concepts are described and verified by large scale experimental tests 

and numerical simulations. The results confirm that the introduced systems can be considered as the new 

generation of resilient damage avoidance LLRSs for timber construction. 

Bio: Ashkan has been a postdoctoral research fellow after he graduated with a PhD degree in Civil and 
Environmental Engineering from UoA. He also has a Master’s degree in Civil Engineering form University 
of Tehran, Iran. His PhD thesis has been awarded a place in the "Dean’s list" and also was nominated for 
the best PhD award from the University of Auckland vice chancellor office. His research interests lie in the 
areas of resilient seismic solutions, earthquake engineering and earthquake resistant multi-story hybrid 
structures. His research findings have been recognised internationally through patents, world-class 
scientific journal publications and international conferences. Ashkan also has over nine years of 
invaluable practical experience achieved through his involvement in professional engineering projects as 
Structural Engineer, Head of Research and Development Office, and Head of Engineering Office. 
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Instructions

You are tasked with designing and building a 1- or 2-story house in
Seattle. You must design your building to resist 3 different earthquakes
capable of being produced by nearby faults.

1. Before building your house, think about the materials you have and
come up with a design.

2. If you think you need more materials, ask a volunteer!

3. Leave space on your roof for concrete blocks, which will represent your
building’s weight.

4. When you are ready to shake your house, tell a volunteer!



Tips

I How will your building resist the earthquake? Most buildings look like
one of the following:

Moment Frame
(Frame Only)

Braced Frame Shear Wall

I Not enough materials? Try mixing the different building types above.

I Test your building before you shake it by holding the base firm while
pushing on the roof.



Nearby Faults

Image from the Pacific Northwest Seismic Network

The Pacific Northwest is threatened by three primary source types:

1. Crustal: shallow and potentially very close to Seattle

2. Intraslab: deeper and along the subducting slab

3. Subduction: megathrust; most powerful but somewhat distant



Northridge (Mw6.7)

Crustal Earthquake
Recorded ground motion obtained from NGA-West2
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The Northridge Earthquake occurred on January 17, 1994 and caused an
estimated $13-40 billion worth of damage in the Los Angeles area.



Nisqually (Mw6.8)

Intraslab Earthquake
Recorded ground motion obtained from IRIS
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The Nisqually Earthquake occurred on February 28, 2001 and caused
damage across the Pacific NW, including the Alaskan Way Viaduct and

numerous brick buildings in Seattle.



Cascadia (Mw9)

Subduction Earthquake
Simulated ground motion obtained from UW’s M9 project
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Earthquakes from the Cascadia Subduction Zone may cause ground
shaking for up to 2 minutes. Scientific evidence suggests its most recent

rupture was around 1700.



Shake-Table Operation

1. ST Configurator
1.1 From the desktop, load ST Configurator if it is not already open.
1.2 Select File → Open and open ShakeTable.st.
1.3 Click Connect.
1.4 Select Tools → Q Programmer.

2. Q Programmer
2.1 Select File → Open Program and open Northridge.qpr from the

/Desktop/Step Driver/2017 folder.
2.2 In the Program box on the left, select Download Program.
2.3 Ensure the table is centered on the rails. If it is not centered, disable

the motor and center the table using your hand. Then, enable the
motor.

2.4 In the Program box on the left, select Execute Program.
2.5 Repeat Steps 2.1 through 2.4 for Nisqually.qpr and Cascadia.qpr.


